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eVSM Functions 

Reference Manual

Use CTRL + F to search within this document

eVSM Help materials include tutorials, examples, and reference. This manual contains the 

reference help. For tutorials and examples, visit evsm.com/help. The manual organization follows 

the organization of the eVSM Toolbar.

The manual is designed both for on-screen viewing and print. For on-screen usage, the manual is 

best viewed in Acrobat Reader. To search, use the Ctrl+F shortcut. Also, it is a good idea to set 

the Acrobat view to "Show two pages side-by-side".

For hardcopy, print the manual on double sided paper and use the table of contents or the index 

to quickly find answers to your questions.
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Value stream mapping provides a high level view of a lean deployment. Its methodology is well 

laid out in the series of workbooks from the Lean Enterprise Institute (www.lean.org). The eVSM 

software has been designed to complement these workbooks and provide lean practitioners a tool 

to support their value stream mapping activities, starting from paper and pencil through 

improvement projects, leading to a leaner future state.

The primary modules in eVSM (Sketch, Sequence, Validate, Calculate, Visualize, Improve) are 

deliberately organized to match the process steps that we have seen practitioners follow in their 

mapping activities.

We have seen eVSM used in three ways in our user community:

1. By practitioners who simply want to capture a map electronically and want access to a 

complete VSM icon set that is easy to use.

2. By practitioners that want to draw a map and do simple calculations in Excel corresponding 

to data on the map.

3. By practitioners who want highly standardized and automated maps to include icons as well 

as variables, lean equations, charts, and improvement methodology. 

While the third approach best leverages the software in a lean deployment, its drawback in the 

past has been the learning curve associated with its usage. eVSM has introduced ready-built 

stencils for different application areas to address this issue. In eVSM v7, the following stencils 

are available. 

§ Quick Enterprise- supply chain and logistics maps

§ Quick Manufacturing- plant level maps for discrete parts

§ Quick Processing- plant level maps for food products and chemical processing

§ Quick Transactional- transactional processes 

§ Quick Healthcare- patient flows in hospitals

§ Quick MCT- supports manufacturing critical path time calculation assorted with Quick 

Response Manufacturing

One hour webinars are available to overview each of the stencils. Contact support@evsm.com for 

details.    

eVSM Overview

1. The eVSM Environment
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Recommended Layout for Quick eVSM

Note that the main eVSM stencil (typically named eVSM vX.XX) is on the right of the screen. 

We will refer to this as the “Main Stencil”. Its important that this stencil is never closed.

Any Quick eVSM stencils (such as Quick Mfg) are docked on the left of the screen. We will refer 

to such stencils as the “Quick Stencil”. Click and drag the Quick Stencil header bar to move it to 

this docked position.

Quick Stencil

Main Stencil

eVSM Pre-requisites and Updates

eVSM requires Windows 2000/XP/Vista/Win7/Win8, Visio 2003-2013, and Excel 2000-2013. 

You can check on the latest eVSM version available at: www.evsm.com/updates

The best way to start a blank value stream map is to double-click the eVSM icon on your 

desktop. If your Visio security setting is set to anything but low, messages will come up 

asking for permission to “Enable Macros”. You must answer “Yes” to these messages for 

eVSM to operate. 

Starting eVSM

The Help button on the toolbar requires an internet connection and will open up a web browser 

pointed to the eVSM help site at www.evsm.com/help.

The help site is tested with Internet Explorer which is the recommended browser if there are any 

problems.

We offer technical support for the latest release of the eVSM software through our Maintenance, 

Enhancement, and Support program.. Please email us at support@evsm.com.

eVSM Help Site

Help
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eVSM has a collection of value stream mapping shapes that appear in the main 

eVSM stencils to the right of the drawing page.

These shapes, behaviors, and corresponding functions have been designed from 

the outset to support the series of lean workbooks from the Lean Enterprise 

Institute (www.lean.org) and its worldwide network partners. The primary 

workbook impacting the design has been “Learning To See”.

As software usage has become widespread across multiple industries, the icon 

language has been extended to keep pace with practitioner requests and lean 

publications in each industry. 

eVSM Shapes & Stencils

To resize the page, hold down the CTRL key and move the cursor to the middle of the edge of 

the page. The cursor will turn into a double-headed arrow. Simply grab the edge and pull it to the 

required size.

Page Resizing

In addition to the basic icons to the right of the drawing page, eVSM includes Quick stencils for 

Enterprise, Manufacturing, Processing, Transactional, and Healthcare. 

These stencils offer rapid map development complete with automated analysis and charting. 

eVSM v7
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Re-opening eVSM Stencils

eVSM Stencils must always be kept open when working with maps. If you have “lost” the eVSM 

stencils from your drawing file, here are the steps to re-open them.

In Visio 2003/2007:

§ Click “File > Shapes > Open Stencil…”

§ Navigate to the following folder: “C:\Program Files\eVSM\Setup\Solutions”

§ Select the eVSMIcons.vss stencil file in this folder and then click the Open button.

§ Save your Visio file so it “remembers” this stencil for next time.

In Visio 2010/2013:

§ In the Shapes pane (on left) click "More Shapes > Open Stencil..."

§ Follow the same steps as above.

Note that on 64-bit Windows, the file location is:  "C:\Program Files(x86)\eVSM\Setup\Solutions"

Resizing Shapes

Shapes are designed to be grid-sized. The drawing page has a grid on it. Snap shapes to grid 

locations for easy alignment.

Snap To Grid

Avoid resizing shapes whenever possible. Shapes are designed to fit together and resizing a shape 

will make “fitting” shapes together difficult and create extra work.

Double-click a shape to edit its text.

Text Editing
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Text on 

Connector

Text on 

Connector

Manipulating Text on Connectors

Text can be added to any connector by double-clicking and typing.

The Visio Text Block Tool can be used to move the text position along the arrow. Note: The Text 

Box Tool is part of Visio, not eVSM tools, and can be found in the Visio menu.

Text on 

Connector

Caution: Be sure to de-select the 

Text Block Tool when finished. 

Drag & Drop

Drag and drop eVSM icons from the stencil onto the drawing page.

Blue icons represent stacks of shapes. Access the stack by dragging out the shape 

and then clicking the right mouse button.

Cross Dock

In_Store Storage

Moment_Of_Truth

Picture Process

Process

Process Cell

Production Control

Rework Process

Shared Process

Warehouse

Process

Manipulating Text

Twice per 

week

Double-click a shape to edit its text.

The Visio Text Block Tool (located behind the Text Tool in the Visio Standard 

toolbar) can be used to move the text relative to the shape location.

The Text Block Tool displays control handles around the text belonging to a shape. 

These control handles can be used to position and size the text block.

Twice per week

Twice per 

week

Text Block Tool

Caution: Be sure to de-select the Text Block Tool when finished. 
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Visio Pages

Pages can be created, deleted, etc. via the right mouse menu on the page tabs.

Rules for Visio drawing page naming:

· Page names must start with an alpha character.

· Page names must be limited to 0-9 and A-Z characters. Characters such as [!@#$%^&*()|+-
?] are not allowed.

· Page names should be kept as short as possible.

Insert Page…

Delete Page

Rename Page

Reorder Pages...

Zooming In and Out

§ CTRL-SHIFT-Drag Select region (Zoom into the selected region).

§ Try the Visio menu “View > Task Panes > Pan & Zoom” for another navigation option with 

a mini-window.

§ To set up the mouse scroll wheel to zoom, use the Visio menus: “File > Options > 

Advanced” and check:

§ Visio 2010 has zoom controls at the bottom right of the window.

Visio shapes can simply be selected, copied and then pasted into other Microsoft office 

applications like PowerPoint and Excel. Be sure to paste a picture using the “Paste As…” 

command. This will allow re-sizing of the pasted picture without requiring editing and font 

adjustments.

Copy and Paste into PowerPoint or Excel

Acrobat PDF

Convert to Bitmap

Acrobat PDF allows capture of any size drawing in a single file, which can be viewed with the 

free Acrobat Reader, and is easily printable. On-screen viewing is good, it is searchable, and 

supports password security. Visio 2010 allows direct creation of PDF files. 

Common bitmap formats such as JPEG, GIF, and TIFF can be viewed in most browsers without 

any additional software. eVSM maps can be converted to these and other graphic formats from 

the “File>Save As…” menu. In the “Save As” dialog, click the “Save as type” pull-down and 

select the format.

Zoom on roll with InteliMouse

Center selection on zoom
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Visio allows drawings of any size. The drawings can then be printed on any size paper supported 

and available on the printer.

When the drawing size does not match the paper size, you can either print across several sheets, 

or shrink (or expand) the drawing to fit the paper by clicking “File>Page Setup…” and then 

checking the “Fit to 1 sheet” radio button.

Printing

The “File>Print Preview” function can and should be used to assess the print output before 

committing the drawing to paper.

Printing Problems

The eVSM Software essentially generates a Visio file. The printing of the file is handled by 

standard Visio functionality. Problems printing from Visio could be due to Visio, the print driver, 

or the printer.

Here are some suggestions if you have problems printing from Visio:

§ Make sure you have the latest Visio Service Patch installed

§ Try copy/pasting your VSM to PowerPoint or Excel and then print from there

§ Convert your VSM to Acrobat PDF and then print the PDF file

8



DON’T  resize eVSM Shapes whenever possible.

DO Snap shapes to grid locations.

DON’T  close eVSM Stencils.

DO zoom in fast with CTRL-SHIFT-Drag.

DO zoom out quickly with CTRL-SHIFT-W

DO use a mouse to be productive with eVSM.

Do’s and Don’ts
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2. Sketch

Overview

Lists the sketcher stencils available and allows one to be selected. The 

corresponding Quick Stencil will also be activated. Note that only one 

sketcher stencil can be used per map.

Open Sketcher

NUM Opens the Name Unit manager which manages the names, units and 

equations used on this map. If used in conjunction with a Quick 

Stencil, its important NOT to modify variable and unit names or 

equations. Typically a few unit names might be added.

View a window showing all data for the selected center.

This section is focused on the first electronic capture of a map and data 

input. This area is ONLY for those using Quick stencils. 

Sketch

List Variables

List Variables

NUM

Open

Wall Map Import a photo of an existing value stream map, and scale for drawing 

the map in eVSM.

Wall Map

How Do I Use the Sketch Module?

The Sketch Module allows you to quickly capture a wall map in eVSM. It can also be used to 

simply capture the flow of the value stream with no data. Built in commands allow you to add the 

data later when needed. The main steps in the Sketch Module are:

1. Use the Wall Map button to import your wall map picture(s) into eVSM, and scale the image.

2. Use the Open button to select the application area (manufacturing, services, etc.) for your map.

3. Use the Sketch stencil to capture the flow over the wall map image. 

4. Once the initial capture has been done, add data to the map and enter the data. 

10



1a. Import Single Image Wall Map

The Wall Map function provides an efficient way to convert an image of the wall into an 

electronic VSM. If your wall map is simple enough to capture in a single clear photo (must be 

able to read all text), then import the image into eVSM with the steps below. If the map is 

complex and requires multiple images then see section 1b on the next page. 

Wall Map

2. Click the Insert Wall Map button to 

browse for your wall map picture on 

your computer.

3. Select the picture and click Open.

4. To scale the picture, draw a rectangle 

over any one process box. Click the 

Done button when finished.

1. Click the Wall Map button in the toolbar.
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5. Next a form will appear allowing you to change the 

transparency of the picture, make it visible/invisible 

on the page, or delete the picture. After you click OK, 

if you need to get back to this form, click the Wall 

Map button in the toolbar again.

1b. Import Multi-Image Wall Map

For more complex maps requiring multiple images, here are some tips for good results:

a.) Take all photos from approximately similar distance from the wall. This will ensure 

similar scale.

b.) Capture sufficient overlap between pictures so nothing is missed.

c.) Ensure lighting is similar for all photos.

d.) Hold camera square to the wall to minimize skewing of the image.

2. Line up the pictures so that the wall map is aligned 

properly. 

1. Use the Insert>Picture option in Visio to import all of the pictures onto your Visio page.

3. Hold down the SHIFT key and select each picture. 

Right-click on the selected images and choose 

“Copy”.  

4. Delete the images from the Visio page.   

5. Right-click on the page and select “Paste Special”. 

Choose the “Picture (Enhanced Metafile)” option and 

click OK.

6. The image will become the background of the Visio 

drawing page, allowing you to drop shapes on top 

without it moving. To delete the image, click the 

Wall Map button in the toolbar. 
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8. Click the Wall Map button in the toolbar, and follow the steps on the previous page of 1a. 

7. Click File>Save As. Name the image and then in the “Save as Type” dropdown, select 

“Graphics Interchange Format (*.gif)”. Click Save.

6. All of the images should now be joined into 

one single image now. Crop or resize the 

image to fit the desired drawing page size. 
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Customer

Process

Type

Process

The shapes shown above are those used in the example map.

As with all eVSM drawings, start your map by dragging out the red shapes (Customer Sketch and 

Time Sketch) first.

1. To start drawing on your map, click on the Open button in the toolbar to open up the 

Sketcher stencil. From the pop-up menu, select which kind of map you’re drawing, for 

example, Quick Manufacturing. There is a separate Sketcher stencil for each of the Quick 

Stencils used in eVSM.  
Open 

2. Once you select what type of map you’re drawing, the corresponding Quick Stencil will be 

placed in the forefront of the other Quick Stencils. Also, the Sketcher stencil will open with 

all of the shapes associated with that type of map.

2. Select Stencil Using the Open Form

5

Wk

day

xx

Wk

shift

xx

shift

Hr
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If you’re using a picture of a hand-drawn map as a guide, start dragging out the different 

Sketch shapes on top of each process as shown below. Otherwise, just recreate your basic 

process using the different Sketch shapes.

An alternative method can be done once a 

red shape has been placed on the drawing 

page. You can use the right mouse button 

menu (shown to the right) and select the 

various Sketcher shapes to drop them at 

the location clicked on the page.

Note: If you need additional map space, 

hold down CTRL and click and drag the edge of the page.

 

Process

Type

Process

Type

Customer

14

Day

Hr

5

Wk

Day

Type

Process Process

Type

3. Capture the Flow with the Sketch Stencil
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Now you can either add data to an individual shape or to the whole map. If you right-click on 

any shape, you will see 4 options regarding the adding and removing of data:

· Add all data (shape): adds input and calculated data to the specific shape that you have 

selected 

· Add all data (page): adds input and calculated data to all shapes on that particular page

· Remove all data (shape): eliminates the input and calculated data from the specific shape 

that you have selected 

· Remove all data (page): eliminates the input and calculated data from all shapes on that 

particular page

For this example, right-click on any shape and select “Add all data (page).

Process
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Process

Type
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Process Process

Type
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4. Add data to the map
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Atlas

Blanks

Mold Handles

Molded Blanks

Customer

Drilled Blanks

Sharpen Assemble

Scissors
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Qty Per Cycle Item5 Qty Per Cycle Item5 Qty Per Cycle Item10

Annotate the map and fill in the values according to your wall map. Now you can finish the 

map by adding arrows from the eVSM main stencil and add-on variables from the Quick 

stencil.
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If you want to create a custom unit that you would like to use throughout the map, start with the 

Name and Unit Manager. If you want to use a built-in unit but need to convert it, such as Weeks 

to Days, start with Step 3.

1. Click the Name and Unit Manager button in the eVSM toolbar.

Units Handling

NUM
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60

Hr

Min

2

Part

Item

60

Hr

Min

3. Drag out a Units Converter shape from the Quick Extras stencil or the main stencil on the 

right of the screen. 

4. Double click on the default unit “Hr” to change the top unit 

to “Part” and the default unit “Min” to change the bottom 

unit to “Item.” This allows the calculator to account for the 

new unit. The top unit is the original unit, while the number 

specifies how many of the bottom unit makes up one of the 

top unit.
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5. If you have more than one custom unit, repeat step two and three.

2

Part

Item

60

Box

Part

1

Inventory Itemxx

A0010

Type

1

Inventory Boxxx

A0020

Type

6. Double-click on the unit.

Note: Only the custom units that you created via a unit converter(s) will appear in the form when 

trying to change a variable unit on a center. This is to avoid (for example) people converting 

quantity units to time units for a center, like the Inventory Center. To ensure that the units you 

want to change appear in the form, create the converters first between any units you plan to use. 

7. This form appears showing 

that it is “legal” to 

convert “Item” to “Box” 

or “Part” because unit 

converters exist between 

these three.

8. Selection of “Box” in the 

form causes the unit to be 

replaced in the data box.
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Miscellaneous Tips

eVSM comes with built-in basic unit conversions that don’t require a Units Converter. To check 

and see which unit conversions are included, open the NUM and click “Unit Converters.”

If the conversion you need isn’t listed, you will need to 

include a Units Converter on your map in order to use 

your units. If the conversion you need is listed then you 

will not need to include a Units Converter. An error 

may appear if you add an additional Units Converter for 

a conversion that is included in eVSM, such as hours to 

minutes.
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The Name & Unit Manager (NUM) provides a simple way of managing the names and units on a 

map via this toolbar button.

The purpose of this management environment is to:

1. Provide a means to type in a name only once and then use it consistently through out the 

map.

2. Provide a means to associate a default unit with a name so that when a name is selected, the 

unit is automatically set.

3. Provide a means of creating a starter set of names and units for different application areas 

such as manufacturing, healthcare, etc. This will allow a company to create standard 

variable sets and deploy them easily.

Managing Names & Units

NUM

The NUM function does not allow editing of names and units directly in the data shapes. New 

names must first be added to the NUM form. Then they can be accessed via right mouse button 

menus on the following data shapes.

Long NVU Short NVU Value Added Non Value Added Units 

Converter

Name Unitx.xx Name Unitx.xx Minx.xx Dayx.xx
60

Hr

Min

The NUM form is divided into three parts: Sets, Units, and Names. Names and units visible in 

this dialog box represent the Current Set. Only the Current Set names and units are available on 

the right mouse button menu of datasets.

Saved Sets

Add New Units

Current Units

Current Names

Add New 

Names

Unit Converter Visibility
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Double-click on “Item/Day,” which will bring up a Unit Selection option. 

The Numerator can be changed to a different name, such as “Screw” rather 

than “Item,” and the Denominator can be adjusted to a different demand, 

such as items per hour. 

If you need to add a new unit, click on “Manage Names and Units…” 

which launches the Name and Unit Manager. 

Fractional Units

eVSM v7 features fractional units that makes computing demand or production much easier. 

Customer

1

Customer 
Demand

Item
Day

xx

For the Customer Center, the default unit is items per day. If demand 

is calculated on a different basis though, it is simple to change the 

units. 

Customer

1

Customer 
Demand

Screw
Hrxx

This shows the original Customer Center 

converted to screws per hour.

When adding a custom unit as a numerator or denominator, it needs to be linked to its units 

family using a Units Converter shape.  For example, if you're trying to change a unit into "$/

Screw," instead of "$/Item," create a Units Converter showing how many Screws are equal to one 

Item. 

If you need to add a different unit of time, such as year, drag out another “Units Converter” 

shape from the eVSM stencil, add a new unit using the Name and Unit Manager, and specify the 

conversion rate. Make sure you add a Units Converter shape before trying to use a customer unit 

as a numerator or denominator in fractional units. It is easiest to keep track of any time 

conversions by placing them next to the Time Center. 

In this example, “Week” was added as a new unit and the conversion to days was made using the 

Units Converter. Next, the Customer Demand was changed to items per week. The new unit 

“Week” can be used in any place requiring a unit. 

8

Day

Hr

60

Hr

Min

60

Min

Sec

5

Week

Day

Customer

Customer 
Demand

Item
Week

500

A0050

A0060
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Process

Data blocks are the blocks in eVSM that contain data and information about the variable. Most 

data blocks appear as an NVU – Name, Value, Unit. In eVSM v7, the data block also has the 

ability to include an image and is called an INNU. A range of sizes and various formats of 

NVU’s are located in the Data Blocks stencil.

Name UnitValue

How are Data Blocks used?

Most data blocks are automatically added to the map when a process shape is added. For 

example, the inventory shape contains a data block defined as “Inventory.”

Staffx.xx

NVU – Name, Value, Unit IVU – Image, Value, Unit

1

Inventory Item3500

A050

Scissors

What are Data Blocks?

In v7, there are right-click options for the data blocks. The 

different options make it easier to customize a data block 

to the specific needs of a map.

List Variables

To see all of the data on a selected center, click the “List Variables” button to bring up a window 

with all of the hidden and visible data.

Click “List 

Variables” 

to bring up 

this form

Select a 

center

List Variables

1
A0080

1

SecAuto

Qty Per Cycle Item2

Cycle Time Sec10

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto
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Process

Using the “List Variables” form you can quickly edit any 

variable by double-clicking on it. For example, the Added 

Cost for the process was changed the $2 per item. 

There is also a useful browsing feature that makes it easier to quickly look at all the variables 

involved with each center. With the “List Variables” form still open, select another center and 

the data form will change to reflect the data of the new selected center. This allows you to update 

and add data without having to select each center separately.

1
A0090

1

SecAuto

Qty Per Cycle Item2

Cycle Time Sec10

Capacity
Item
Day

Auto

Pre OEE 
Capacity

Item
Day

Auto

OEE Percent %Auto

25



The eVSM Key Creator generates a key of the icons used on the current drawing.

Drawing a Key of Icons

Drag out the Key Creator icon from the eVSMIcons stencil and drop it in the space on your map 

where you want to display the key. 

Note: This automatic function is restricted to eVSM shapes on the current drawing page. Some 

eVSM shapes, eg. data shapes such as long and short NVU’s are intentionally omitted.

The Key display uses the eVSM Table shape. This allows you to delete/add columns (see how in 

the “Working with Tables” chapter) and also change the annotation of the key.

Cross 
Dock

Finished 
Goods

Inventory
Outside 
Source

Process Summary Truck
Units 

Converter
Warehouse

Cross Dock

Outside

Source

Process Summary 60.00

Hrs

Mins

Warehouse

Key Creator

Cross Dock
Finished 
Goods

Inventory
Outside 
Source

Process Summary Truck
Units 

Converter
Warehouse

Cross Dock

Outside

Source

Process Summary 60.00

Hrs

Mins

Warehouse

26



Aliases are a feature in eVSM that allow a user to convert the variables into another language. 

They can also be used for companies that have a common language that is different than eVSM, 

such as referring to “Stations” as “Worktables.” Using Aliases allows a map’s names and 

variables to be easily updated to fit your needs. 

To start, first create an Excel file with two columns. In the first column, make a list of all the 

variables you would like to create an alias for. In the second column, list whatever you would 

like to variable to be changed to, like using the term “Employees” instead of “Associates,” or 

translating the eVSM term to another language.

In this example, the English eVSM terms are converted to German. Make sure that you label each 

column since the Alias converter starts on the second row in the Excel file. 

Also, label each page in your Excel file to whatever alias you’re using, such as Spanish or the 

company language.  

Aliases
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The conversions can be done on the entire list of variables and units or just on a select few. In the 

example below, the company only wants to use aliases for a few of the variable names so that 

their maps closer resemble terms used in the company.

Once your alias Excel file is complete, draw your map in eVSM or open an existing map. Open 

up the NUM by using the button on the eVSM toolbar or by double-clicking on the NUM data 

shape.  

Click on the “Import” 

button in the NUM.
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Locate the file on your computer and open 

it. A dialog box will appear asking which 

worksheet you would like to use. This 

example will start with the German 

worksheet. 

Once you hit “OK,” the variables and units 

in the map will be changed to whatever was 

listed as the Alias. The map below shows 

the updated terms.

If you would like to switch back to the default eVSM names, open up the NUM and turn the 

Import Mode off.
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To use a different set of aliases, copy the map to a new page (except for the NUM) and drag out a 

new NUM. Import the same data file as before but use the Company Language worksheet instead. 

Now, the map shows terms that are used by the company.
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Adding a new variable

If you want to add in a new variable with an Alias, click on the “New Name” button in the NUM.

Fill in the Name and then the Name Alias. 

Note that the Name will be used when the 

Alias Mode is off and the Name Alias will 

be used when the Alias Mode is on. 

Now that the name is added to the NUM, it 

can be added to the map and it will change 

when the Alias Mode is on or off.
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Process

1

Qty Per Cycle Item1

Cycle Time Minx.xx

1

A0010

MinAuto

1

Inventory Itemxx

A0020

Type

DayAuto

To move the timeline and get it aligned, you can simply click on the VA or NVA shapes and 

manually move them. Alternatively, if you want to shift the entire timeline up or down you can 

right-click on any of the timeline shapes and choose “Select Timeline.” If that option doesn’t 

appear in the menu, make sure you have the entire VA or NVA shape selected and try again. 

With the entire timeline selected, you can then move it to where you’d like it. Similarly, in the 

right mouse menu there is an “Align Timeline” function that will create the ladder timeline for 

you if the VA and NVA shapes are not correctly aligned, as shown below.

Selecting & Aligning Timeline

MinAuto

DayAuto

   Disable Flying Connector

   Select Timeline

   Align Timeline

MinAuto

MinAuto

DayAuto

MinAuto

eVSM is designed as a grid system and each shape should fit neatly into the lines. If the shapes 

aren’t in the grid, it could lead to later issues and so lining everything up should become a habit. 

It is best to line up the bottoms of each green center and then adjust the timeline, as shown 

below. 
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3. Sequence

Set tag and path defaults that are used for auto-numbering shapes as 

they are dropped on the page.

First select the activity shapes using the shift key and in the 

CORRECT sequence and then click this button to create sequence 

arrows. This can be done a few shapes at a time. Note that the 'Check' 

section in the toolbar does have a hide/show for sequence arrows. 

Sequence arrows are critical to upstream/downstream calculations on 

the map. No sequence arrow loops are allowed.

Many of the calculations on the value stream map rely 

on the process sequence. This is defined on the map by 

using process tags, path numbers, and sequence 

arrows. 

Tag & Paths

Sequence

Tag &

 Paths
Sequence

Tag &

Paths
Auto Path

Auto Tag

Sequence

Identifies each unique path through the value stream (via tag sequence 

arrows) and adds path ID’s to steps.

Assigns tags in the order provided by tag sequence arrows.

Auto Path

Auto Tag

Select Paths Select only the paths in the value stream you want to map (useful 

when there are many split routings).

Select Paths

Auto Pipe Select the activity from which to originate the pipe arrows, then hold 

down the shift key and select one or more activities to pipe to.

Auto Pipe
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Process A Process B

15CT Min 20CT Min

15
Accumulative 

Time
Min 45

Accumulative 
Time

Min

A010
A020

A030

Transport 
Time

Min10

Managed Equation

Accumulated Time =

ST(CT;Min;0;APPLY)

  + ST(Transport Time;Min;0;APPLY)

    + UTS(ACCUMULATIVE TIME;MIN;0;APPLY;SUM)

After your shapes have been sequenced, there is an option to automatically generate the path IDs 

for all the possible paths on the map based on the sequence arrows. After shapes have been 

sequenced using the “Sequence” button in the toolbar, click “Auto Path” in the toolbar. This will 

automatically give paths to the shapes in the order that they have been sequenced. 

Auto Path

Auto Path

Process

Name Unitx.xx Name Unitx.xx

Process

Name Unitx.xx

A04

0

A05

0

A06

0

A07

0

A08

0

2 2 2

1

1 1 1

1 2

Sequence

Sequence

There are two ways to attach tag sequence arrows to tags. The first is to drag out the arrow from 

the stencil and then glue the two arrow ends to the tags. The second method is to select a series 

of tags (or activities) in the correct sequence and then click the eVSM Sequence button in the 

toolbar.

If these shapes do not already have tags, using the AutoSeq button after having selected them in 

order will automatically attach tags to each shape.  

The Tag Seq Arrow is used with Managed Equations and allows you to perform upstream and 

downstream calculations.

The example on the following page shows how Accumulative Time can be calculated along the 

value stream with the use of Tag Seq Arrows.

Warning: AutoPath regenerates path numbers 

for all shapes connected by sequence arrows 

and without consideration of the current path 

number on these shapes.

Some summary center shapes are NOT on 

sequence arrows but often have path numbers 

on them. These path numbers should be 

corrected manually after using AutoPath.
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Using Visio Spline Tool 

Another quick method to creating sequence arrows on shapes in order is by the Visio spline tool 

located in the ‘Home’ tab of Visio. Click the drop-down arrow to change shapes and choose the 

“Freeform” option. 

Draw a line through the flow of your map. Next click the Sequence icon in the eVSM toolbar and 

sequence arrows will be attached, as well as tags if they were not previously there. After clicking 

Sequence, with the freeform line selected, you may click Auto Path to automatically add path 

numbers to the shapes just sequenced. This is an easy alternative to generate arrows, tags, and 

paths especially for larger maps.

Process Process Process

Process Process Process

A10

0

A11

0

A12

0

Sequence

Tag numbers can also be named manually. However, the name must be unique and must be one 

letter followed by four numbers.

Each tagged shape will generate a row in the spreadsheet. Any data associated to that shape (via 

gluing) will appear in that row. Excel rows are alphabetically sorted by tag number.

A quick way to tag activities in order automatically, based on the sequence arrows is to use the 

eVSM Auto Tag button.

AutoTag

Auto Tag

Tag & Paths

The Auto Tag function works by re-tagging the whole map, so it disregards what you want as the 

“Next Value” in the Tag and Paths form.  It orders the shapes by tag sequence arrows and then z-

order (for un-sequenced rows). Then, it goes through the sequence, and it increments each tag by 

the user-assigned interval (in the Tag and Paths form), but otherwise numbers start at 0010 for 

each letter prefix.

The activities will be tagged starting with the tag number and increment value as specified in the 

form under the ‘Tag and Path Default’ button.
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The Path Locater is used to identify a path that an activity (or other shape able to be tagged) 

belongs to. The shape is glued above the top right corner of the shape.

Path Locater

Stamping

A130 2 1A140 1

A150 1

Type

xxInventory
Ite
m

AutoTakt Time Min

Auto
Total Value 

Added
Min

AutoLead Time Day

Auto
Value Added 

Percent
%

Z060

Time Summary

14

The Path Locater

An activity can belong to no paths, one, or more paths. In the example above, the “Stamping” 

activity belongs to path 1 and 2. Similarly, the Time Summary will show results for the sum of 

Paths 1 and 4.

Path locaters can be glued to each other as long as at least one of them is glued to the activity 

shape.

The benefit of assigning path numbers to activities is that the associated activity variables (like 

NVA time) can be summed up across the map in a path specific sense. 

To add or change a path locator, first select the shapes you wish to attach a path locater to. Click 

on the “Tag & Paths” button in the toolbar. This will open a dialog box that allow you to choose 

a path number. After selecting the path number, click the “Add Path Locators” button.
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Select Paths

The Select Paths function is used to select the paths in the value stream that you are interested in, 

and eliminate unnecessary Path IDs for the rest. This is useful when there are many split routes. 

After you have sequenced your shapes and used AutoPath, click the “Select Paths” button in the 

toolbar. 

Once you have selected which paths to include in the form and clicked OK, the path IDs will 

regenerate to only show the paths you have chosen, as displayed on the next page.

Click to highlight the shapes for each path on the map

Check which paths 

you would like to 

include on the map
The shapes 

involved in Path 1

Process Process

Process

Process Process

Inventory

Process

Inventory

Process

Inventory

Truck

Truck

Truck

A010 A720

A020

A030
A040

A050
A060

A090

A100

A070
A080 A110 A12012

12

12

12

12

12

34

34

34

14

14

23

23

13 24

Select Paths
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Process Process

Process

Process Process

Inventory

Process

Inventory

Process

Inventory

Truck

Truck

A270 A280

A290

A300
A310

A320
A330

A340

A350

A360
A370 A380 A3901

1

1

1

1

1

2

2

1

1

1 2

2

2

2

Truck

Auto Pipe

This function allows you to automatically create pipe arrows from one center to many centers. 

Alternatively, you can create the pipe arrows from many centers to one center. The main use is 

for resource allocation. By adding pipe arrows you can determine which resources are used for 

which activities. To use this function, select the center from which to originate the pipe arrows 

then hold down the shift key and select one or more centers to pipe to. 

Auto Pipe

Activity B

Activity C

A0420

A0430Resource PT
Min
Item2

A0440

Resource PT
Min
Item3

For example, first Resource A was selected and then while holding shift, Activity B and C were 

selected. Then the “Auto Pipe” button was used to automatically create pipe arrows from one 

activity to many activities. The pipe arrow data shows that Resource A is used for 2 minutes per 

item for Activity B and 5 minutes per item for Activity C. 

Resource A
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4. Validate

Overview

Must do this before using the Solve button. Performs numerous 

checks on the model and reports back any problems.

A visibility toggle switch for tag sequence arrows. Generally 

recommended that you work with these visible so you can fix 

sequence arrows as you modify the map.

Removes various highlighter shapes used for glue display or 

problems displayed by the software.

This section contains checking functions to validate the model 

ahead of analysis. 

Check

Show Seq.

Clear

       

Check

Show Seq.

Clear

Validate

Show Pipes

Show Pipes Just a visibility toggle switch for pipe arrows. Generally 

recommended that you work with these while visible so you can 

fix pipe arrows as you modify the map.
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Missing Data: Data Shapes which are not properly associated to Rowmaker Shapes (via gluing) 

will be missed in the data transfer and are highlighted. 

Missing Units Converter: If a variable is used with more then one unit (eg. Cycle time in 

minutes and seconds), then a units conversion factor must be provided. Standard time units (e.g. 

sec, min, hr, day) are already included in the time center and don’t require a units converter. 

The Tag Sequence Arrow visibility can be set with the switch in the eVSM Toolbar:

Use the button below to clear any highlighters off of the map created by the Glue Connector.

Show Seq.

Clear

The Check function highlights some common problems on the map with a red circle and checks 

the model. To run, click this toolbar button:

Problems fixed by the Check function include:

1. Removes hidden data shapes: sometimes when using copy/paste, multiple copies are 

created and duplicates are hidden under visible data shapes. Finding and removing these 

can be tedious, so ‘Check’ automatically deletes such duplicates.

2. Automatically glues data shapes and arrows based on proximity.

3 Works around the Visio glue limitation of 10+ shapes.

Check

Check

Mold Handles

55Cycle Time Secs

2.5
Changeover 

Time
Hrs

22Defects ppm

4Operators Staff

96Yield %

85Uptime %

Mold Handles

55Cycle Time Secs

2.5
Changeover 

Time
Hrs

22Defects ppm

4Operators Staff

96Yield %

85Uptime %

Before After
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5. Calculate

Overview

Writes data out to excel, performs any calculations specified via 

managed equations and displays results back on the map. Also updates 

gadgets and charts on the map.

This section links the map to an underlying Excel spreadsheet to 

perform lean calculations with the results displayed back on the map. 

Solve

Variational Solve Calculates values using variational data.

      Solve
Calculate

Var Solve

Tag Operation VA NVA Data Data Data Data

v
a
lu

e
 a

d
d

e
d

n
o

n
 v

a
lu

e
 a

d
d

e
d

c
y
c
le

 t
im

e

d
is

ta
n
c
e

re
w

o
rk

 (
%

)

y
ie

ld
 (

%
)

secs days secs ft % %

A010 Build xx 22.00 5.00 96.00

A020 Hand Cart 135.00

A030 Pack xx xx 22.00 2.00 96.00

Excel

Build

A10

22Cycle Time Secs

96Yield (%) %

Pack

22Cycle Time Secs

96Yield (%) %

A30A20

135

Distance

ft

5Rework (%) % 2Rework (%) %

xx Days

xx Secs xx Secs

Visio

The eVSM Solve button in the toolbar provides bi-directional transfer of information between the 

map and a spreadsheet. When the button is clicked for the first time in a map, eVSM 

automatically creates a new Excel file and puts it in the same folder the Visio file is saved in. 

The function only operates on the current map page.

The eVSM Calculator

Solve
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Variational Data

eVSM now supports simple means of specifying variation in data for selected input values and 

creates variational output for designated calculated values. The example below pulled from a 

Quick Transactional example map.

1. A Normal Distribution icon from the main stencil has been dragged out and glued to the 

Delay Time variable.

2. The mean and standard deviation for the activity’s delay time was entered.

1

Process Time Min55

Qty Per Cycle
Doc
Cyc

1

A0030

Delay Time Hr12

C&A Percent %95

Accept Order

2

412
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3. We want to see what effect this will have on the Lead 

Time. The Output Variation icon from the main stencil 

has been glued to the Lead Time of the Summary Center. 

1

Summary

Total Value 
Added

Min127

Lead Time Day3.80

Value Added 
Percent

%6.96

Z0350

Total Processing 
Time Needed

Min
Day

1320

Total Delay 
Time

Min1098

First Pass 
C&A

%64.47

4. The Variational Solve button is selected and the user 

selects ‘75’ solve iterations. Each solve uses a random 

number generator to “pick” a value from each variational 

input. It also creates a sample output for each designated 

out variable. This is a simple type of Monte Carlo 

analysis.

Var Solve

5. Right-click on the Output Variation shape and select “Plot 

Output Distribution”.

Lead Time (Day)

5
0

%
 <

 3
.8

7

8
5

%
 <

 4
.4

8

9
5

%
 <

 4
.8

4

9
9

%
 <

 5
.2

5

6. The Lead Time has been plotted with the various 

confidence levels.
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1. Connect the Variation Percentile shape to the target variable (lead time in the example below), 

and set it to 95.

2. Create a managed equation that equates lead time to the sum of the cycle time.

3. Press the Solve button in the toolbar and note that the lead time solves to 63.16. Without the 

percentile specification the answer would have been 50.

Variation Percentile Shape

Process Process
Summary

A0020 A0030 A0040

Cycle Time Min20 Cycle Time Min30

Lead Time Min63.16

820

95

The Variation Percentile shape, when attached to a variable that is calculated via an equation, 

provides a way to access percentile values for any terms in the equation that have an associated 

distribution. In the example below, lets say we want to calculate a lead time that will not be 

exceeded 95% of the time.
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Data Source and Data Target is used to link the data from different shapes or pages. In this 

example, the main map has an Assembly station that is actually a multi-machine. The data from 

the Multi-Station Wizard will be linked to the main map for the center.

The main map is below, with the multi-machine beneath it.

Source and Target

all

Customer 
Demand

Item
Day

7000

A010

Customer

1

Activity Lead 
Time

Day0

A020

Atlas

1

Inventory Item7500

A030

Blanks

DayAuto

Sharpen

1

Qty Per Cycle Item5

Cycle Time Min1

1

A040

MinAuto

1

Inventory Item3000

A050

Molded Blanks

DayAuto

Assemble

1

Qty Per Cycle Item10

Cycle Time Min2

1

A060

MinAuto

1

Inventory Item9000

A070

Scissors

DayAuto

OEE Percent %75

Stations Stn1

123

M1

1

Qty Per 
Cycle_M

Item1

Cycle Time_M Min4

Cycle Time Per Item Min2.00

Capacity Per Day Item240.00

Stations_M Stn2

Activity 
Time_M

Hr
Day

10

OEE 
Percent_M

%80

CT Capacity Per Day Item300.00

QPC Contributor ItSq300.00

All Stations Time Hr
Day20.00

A0100

M2

1

Qty Per 
Cycle_M

Item1

Cycle Time_M Min2

Cycle Time Per Item Min2.00

Capacity Per Day Item324.00

Stations_M Stn1

Activity 
Time_M

Hr
Day

12

OEE 
Percent_M

%90

CT Capacity Per Day Item360.00

QPC Contributor ItSq360.00

All Stations Time Hr
Day12.00

A0110

M3

1

Qty Per 
Cycle_M

Item1

Cycle Time_M Min6

Cycle Time Per Item Min6.00

Capacity Per Day Item119.00

Stations_M Stn1

Activity 
Time_M

Hr
Day

14

OEE 
Percent_M

%85

CT Capacity Per Day Item140.00

QPC Contributor ItSq140.00

All Stations Time Hr
Day14.00

A0120

Multiple Station Equiv.

1

Stations Stn4.00

MS Capacity 
Per Day

Item683.00

Activity Time
Hr

Day
11.50

MS CT Capacity 
Per Day Item800.00

MS Cycle Time Per 
Item Min0.86

OEE Percent %85.38

Qty Per Cycle Item1.00

Cycle Time Min3.45

Z0050

123
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The Assemble activity center on the main map is represented by the equivalent multi-machine. 

The goal is to populate the input fields for the Assembly activity from calculated values on the 

multi-machine map. The Multi Station Wizard has been purposely designed so that it calculates 

the values that the activity on the main map needs AND has the SAME variable names (Cycle 

Time, Stations, etc.). In the special case where source and target variable names are identical, 

source and target identifiers can be glued to the center shape as shown below.

1. After you have created a multi-station wizard, name the page to MS. Drag out the “Data 

Source” marker from the Quick Extras stencil (or the main stencil) and glue to the Multi 

Station Summary Center. Note that source variables can be located on the same page as the 

target variable or on another page in the same file.  Enter an ID, like 123 which will be 

used for the target marker as well.

Linking Variables with the Same Name

Multiple Station Equiv.

1

Stations Stn4.00

MS Capacity 
Per Day

Item683.00

Activity Time
Hr

Day
11.50

MS CT Capacity 
Per Day Item800.00

MS Cycle Time Per 
Item Min0.86

OEE %85.38

Qty Per Cycle Item1.00

Cycle Time Min3.45

Z0010

123
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Note that the default setting for the target variable is set 

to sum all of the source variables. You can right-click 

on the target and change sum to average, max, or min.

2. Go back to the main map page and drag out a “Data Target” marker and glue to the side of 

the Activity Center. Enter 123 for the ID. In order for the calculation to be correct, the first 

five variables from the multi-station summary center MUST be on the Activity Center. If 

they are not, you will have to manually drag them out from the Quick stencil and glue to 

the Activity Center.

3. If the source and target variables are on separate pages, the page where your target variable 

is must be linked to the source page. Make sure each page in your Visio File has a 

memorable name in order to differentiate pages when setting the scope. 

Assemble

1

Qty Per Cycle Item1

Cycle Time Minx.xx

1

A0040

MinAuto

123

Stations Stn1

OEE Percent %x.xx

Activity Time
Hr

Day
x.xx
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6. On the main map page, click the “Solve” button in the toolbar. See how the target variable 

is able to access the source variable values automatically as part of the solve as seen in the 

Assemble activity center. You must have a value entered in each of the x.xx fields, even if 

it is 0, or the solve function won’t run. 

Notice how the Assemble activity matches the 

values of the multi-station equivalent machine 

summary center.

Solve

Assemble

1

1

123

A0010

Stations Stn4.00

Activity Time
Hr

Day
11.50

OEE %85.38

Qty Per Cycle Item1.00

Cycle Time Min3.45

4.  In this example, go to the main map page where your target is and click the NUM button in 

the toolbar to open the dialog box to set the page scope. 

5. Click “Source/Target Pages” at the 

bottom of the box and select the page 

on which your source marker is 

located. 

NUM
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Linking Variables with Different Names/Units

In the general case when you are trying to link values of variables with different names, you 

should glue the source/target markers onto the side of the variable as opposed to the whole 

center.

Activity

1

Qty Per Cycle Item1

1

A0050

CT Hr0.13 1

Multiple Station Equiv.

1

Stations Stn4.00

MS Capacity 
Per Day

Item198.00

Activity Time
Hr

Day
11.50

MS CT Capacity 
Per Day Item348.00

MS Cycle Time Per 
Item Min1.98

OEE %56.90

Qty Per Cycle Item1.00

Cycle Time Min7.93

Z0010

1

60

Hr

Min

If the units are not the same, there must be compatible 

unit converters, like Min to Hr, located on the source 

page for the solve function to convert the value. If the 

units are not compatible and you try to solve, an eVSM 

Warning message will appear telling you to create a unit 

converter. See the example below which shows different 

variable names and units, but was able to link the values 

because of the correct unit converter.

Target Page

Source Page
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eVSM has an XL Report builder that will export the 

tag, operation, type, and custom variables one 

directionally to Excel. 

1. After your map has been solved, drag out the XL 

Report icon the eVSM Icons stencil. 

XL

Report

2. Right-click on the XL Report shape and select “Edit Report Data”.

3. Enter a Report Name which will 

be the page name in the Excel 

file. 

4. Click “Add” to create a category 

header. 

5. Click “Add” to select the 

variables to the export to the XL 

Report. 

6. Select the desired variable from the dropdown 

menu.

7. If you don’t want the default unit, uncheck this 

box and change the units manually. 

XL Reports
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Tag Operation Type Time

C
yc

le
 T

im
e

C
u

st
o

m
e

r 
D

e
m

a
n

d

Min Item/Wk

A0010 Prepare 5

A0010_A0020

A0020 Paint 10

A0020_A0030

A0030 Package 8

A0030_A0040

A0040 Customer 100

8. After you have finished adding the desired variables, right-click on the XL Report shape and 

select “Run Report”.

XL

Report

Edit Report Data

Run Report
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6. Visualize

Overview

Allows management of gadget families providing geometric views of 

key numbers of the map with color coding, scale factors and hide/

show.

Updates all the geometric gadgets based on the current map values.

The view capability simplifies maps with better utilization of map 

space. Also allows the visualization of the numbers using gadgets and 

charts. 

Gadgets

Update

Views Opens a window for modifying variable visibility settings for the map.

Visualize

Update

Gadgets

Views
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To prevent maps from looking crowded, there are a large number of variables in eVSM that are 

hidden. Click the Views button in the toolbar to hide/show any variables. This will open the form 

below which allows you to manage the visibility of variables on the map. The dark gray boxes 

indicate the hidden variables on the map. Once OK is clicked, the changes will apply to all 

centers on the map. Views

Hiding & Showing Variables

The white variables shown in the menu are the visible variables while the gray variables are 

hidden. Check the box next to the variable to make it visible. There are four options at the 

bottom of the menu for various quick views.

1. Default: Reverts back to how the centers and variables look when dragged out from the stencil.

2. Hide Auto: Hides all blue calculated variables.

3. Hide All: Hides all variables on the page.

4. Show All: Makes all variables visible.
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Any data on the map can be linked to visual gadgets that change in size and color with change in 

the data. Some gadget types are shown below:

Sq. 
Area 

Gadget

Tr. Area 
Gadget

Slider 
Percent 
Gadget

Arc 
Angle 

Gadget

Line Tk 
Gadget

Bar 
Height 
Gadget

Curve Tk 
Gadget

Each gadget has exactly one size parameter that can be tied to a data value on the map. Here’s 

the typical means used to apply and manipulate gadgets:

1. Drag out the gadget from the main eVSM stencil and position it near the data value with 

which it will be associated (in this case the “Cycle Time”). In this example the Bar Height 

Gadget is being used.

Bar Height 
Gadget

Using Gadgets to Visualize Data

Process

Cycle Time Min2

2. This system shape will be automatically dropped on the page the first time a gadget is used. 

If you copy a map to a new page make sure you also copy this shape because it is used to 

hold gadget data for the map.

3. Select the gadget, drag and glue the gadget’s yellow flying connector to the side of the 

NVU data shape (avoid gluing to the top or bottom of the data shape).

Process

Cycle Time Min2
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4. Right-click on the gadget and use the “Activate Gadget” option to create a new gadget 

collection. The collection name will be “Bar_Cycle Time”. The name is created from the 

gadget type and the data variable name.

A gadget can only belong to one collection. Each collection can only have a single type 

(eg. “Bar”) of gadget.

Activate Gadget

Create Gadgets By Example

Show Gadget Collection

Manage Gadget Collections

5. You can change gadget scale factors and color code them by modifying the properties of 

the associated Gadget Collection. You can easily create additional gadgets tied to other 

instances of the same data on the map. Just click on the gadget and use the right mouse 

button to select “Create Gadgets By Example” to create the gadget for Process B below.

Process A

Cycle Time Min2

6. Note that the new gadget is automatically positioned, scaled and put into the same 

“Bar_Cycle Time” collection. If you do not wish to have new gadgets created for the whole 

map than select the original gadget, then sub-select an area of the map before using the 

“Create Gadgets By Example” menu.

Process A

Cycle Time Min2

Process B

Cycle Time Min6

Activate Gadget

Create Gadgets By Example

Show Gadget Collection

Manage Gadget Collections

Process B

Cycle Time Min6
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7. To modify a gadgets scale factor or to color code it, you need to change the properties of its 

associated collection.  Right mouse click on the gadget and select “Manage Gadget 

Collections,” or click the Gadgets button in the toolbar.

Gadgets

You can color code 

the gadget fill and 

font colors based on 

the value of the data 

to which the gadget 

is glued. You can 

also simply “inherit” 

the color from the 

data shape or assign a 

color to a gadget 

manually.

You can modify the scale 

factor for a collection that 

controls gadget size in 

relation to data value. Use 

the Apply button to see the 

new  gadget sizes on the map 

before exiting the form.

To hide or show gadgets in 

a collection, first select the 

collection from a list, then 

click this button.

Note: the collection list has 

a column indicating 

visibility status.
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§ Gadgets have a single size parameter that will scale to the data value in which a gadget is 

glued via the flying yellow connector.

§ Gadgets are typically glued to NVU, VA or NVA shapes. When gadgets in a collection are 

glued to data shapes with different units, Units Converters are needed on the map to 

compute the correct scale factors.

§ Gadgets have to belong to a collection. They can be put in a collection using the Activate 

Gadget command or by transferring them into a collection via the Manage Gadgets form.

§ Gadget scale factors and color coding can be controlled via the Manage Gadgets form.

§ An easy way to create a gadget “set” after creating a first gadget is to use the Create 

Gadgets By Example in the right mouse button menu.

§ The Visible switch on the Manage Gadgets form is very useful in showing different 

metrics on the map in a presentation environment.

§ See the “Examples” section on the eVSM help site (www.evsm.com/help) for usage 

examples of the different gadget types.

§ A starter set of gadgets is provided with eVSM. Additional gadgets can be requested by 

contacting support@evsm.com.

Gadget Tips

59



Cycle Time Min6

Enable Flying Connector

Name Help

________________________

Select all with Name

Select all with Name on Path

Edit Name.. (Cycle Time)

Edit Unit.. (Min)

Plot Name Values

Plot Distribution Values

There is now the option to plot the name values for all variables on the map. 

Plot Name Value

Try This:

1. Drag out three activity centers and fill in the values.

2. Right-click on Cycle Time and select “Plot Name Values” in the menu.

Wash

1

Qty Per Cycle Item1

Cycle Time Min4

1

A0030

MinAuto

Drill

1

Qty Per Cycle Item1

Cycle Time Min2

1

A0040

MinAuto

Inspect

1

Qty Per Cycle Item1

1

A0050

MinAuto

VSM - Cycle Time

M
in

0

1

2

3

4

5

6

A080

D
ril
l

A090

W
as

h

A100

In
sp

ec
t

Cycle Time

Legend
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Plotting VSM Charts 

XY Charts (Combination & Pareto Charts) - Any numeric data available for analysis in eVSM 

can be plotted on a chart such as this:

Cross Dock

Assemble

30Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Test

10Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Ship

500Defects ppm

Drill

20Cycle Time Secs

1Operators Staff

50Batch Size Pairs

Sharpen

75Cycle Time Secs

15
Changeover 

Time
Hrs

1Operators Staff

50Batch Size Pairs

Mold Handles

53Cycle Time Secs

2
Changeover 

Time
Hrs

2Operators Staff

50Batch Size Pairs

38500

Scissors

Pairs 27000

Scissors

Pairs 31000

Scissors

Pairs 7000

Scissors

Pairs 5000

Scissors

Pairs75000

Scissors

Pairs

ATLAS 

Warehouse

1

Frequency

Per 
Week

1

Frequency

Per 
Week

MRP

Production

Control

Forecast 30 Days
Weekly Order

Daily

Daily

130.00 Secs

4.17 Days

75.00 Secs

2.14 Days

20.00 Secs

1.50 Days

30.00 Secs

1.72 Days

10.00 Secs

0.39 Days 0.28 Days

Weekly Schedule

Summary

18000Daily Demand Pairs

10.19
Production 
Lead Time

Days

265.00
Processing 

Time
Secs

Daily Ship Schedule

5

Wks

Days

2

Days

Shifts

7.5

Shifts

Hrs

60

Hrs

Mins

60

Mins

Secs

Plant Summary

2.00
No of Shifts 

per Day
Shifts

5.00
No of Work 

Days per Wk
Days

15.00
Production Hrs 

per Day
Hrs

500.00Defects ppm

62.50Raw Materials Hrs

4.17
Finished 
Goods

Hrs

86.25
Work in 

Progress
Hrs

67Takt Time Secs

A10 A20 A30 A40 A50 A60

A70

B10

B20

ACME Scissors

Current State Chart

Maker

Cycle Time - Takt Time Chart

S
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40
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80

A010

M
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d 

H
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S
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A030

D
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l

A040

A
ss

em
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e

A050

Tes
t

Cycle Time

Takt Time

Before creating a chart, you must ensure that the data to be plotted is:

- Contained in eVSM data shapes

- The data shapes are glued to the parent rowmaker shapes

- Rowmaker shapes are tagged with Operation Tags

Hint: Use the Glue Check and Excel Check buttons in the eVSM toolbar to verify

1. Drag out the XY Chart icon from the stencil, and place it anywhere on the map. 

2. Set up chart parameters and click “Plot Chart” command in the right mouse button menu.

XY Chart
XY 

Chart

Edit Chart Data

Plot Chart

Create Spreadsheet

Right mouse click on the shape and 

select the “Edit Chart Data” command.

Try This:

Select data 

variables (eg. 

Cycle Time) to plot

Set data filters

Enter chart title
Select Y-axis 

units

Optional chart 

description

Variables will be plotted in 

sequence shown here. 

Use Up Down buttons to 

change sequence
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Options for Chart Variables:

3. Click the Plot Chart command in the 

right mouse button menu.

Notes:

§ Each eVSM Chart is a group of simple shapes. Avoid ungrouping these as this may displace 

some of the shapes.

§ Chart will update automatically when the Calculator is run. To update the chart manually, 

use the “Update command in” the chart’s right mouse button menu.

Edit Chart Data

Plot Chart

Create Spreadsheet

Set a default value for non-

existent plot points

Select Variables to plot

Select Display Type

Enter Tag number for 

single tag data plot

Set color of fill or lines

Sales Milestones

90Order Approved Days

10
Order Shipped 
to Customer

Days

0Order Accepted Days

A003
0

Manufacturing 
Milestones

80
Manufacturing 

Begins
Days

30
Inspection 
Complete

Days

15
Manufacturing 

Complete
Days

A004
0

Milestone Charts

Try This:

Sales & Manufacturing Milestones
Days

90 80 70 60 50 40 30 20 10 0

Sales Milestones

Manufacturing Milestones

Order 

Approved

Order Shipped 

to Customer

Order 

Accepted

Manufacturing 

Begins

Inspection 

Complete

Manufacturing 

Complete

1. Get data ready in this format:
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2. Drag out the Milestone Chart icon and click the “Edit” 

command in its right mouse button menu.

3. Complete the form:

4. Plot chart.

5. Use the “Update..” command in the chart’s right mouse button menu to update the chart 

when the data changes.

Sales & Manufacturing Milestones
Days

90 80 70 60 50 40 30 20 10 0

Sales Milestones

Manufacturing Milestones

Order 

Approved

Order Shipped 

to Customer

Order 

Accepted

Manufacturing 

Begins

Inspection 

Complete

Manufacturing 

Complete

Update Milestone Tag Chart

Milestone 

Chart

Edit Milestone Chart Data

Plot Milestone Chart

Create Spreadsheet

Edit Milestone Chart Data

Plot Milestone Chart

Create Spreadsheet

Milestone 

Chart

Milestone 
Chart

Cumulative Bar Charts

The Cumulative Bar Chart allows you to visualize the phases of a value stream on a timeline.

Order Fulfillment Timeline

Days

0 5 10 15 20 25 30 35 40

Process 

Order

Order 

Approval

Scheduling Wait for Mfg Manufacturing Wait for 

Delivery

Delivery

1. Get data ready in this format:

2. Drag out the Cumulative Bar Chart icon 

and click the “Edit” command in its right 

mouse button menu.

Cumulative 

Bar Chart
Edit Cumulative Bar Chart Data

Plot Cumulative Bar Chart

Create Spreadsheet

Cumulative 
Bar Chart

Order Fulfillment 
Timeline

1Process Order Days

8Order Approval Days

3Scheduling Days

15Wait for Mfg Days

10Manufacturing Days

1
Wait for 
Delivery

Days

2Delivery Days

B070
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4. Plot the chart:

5. The chart will update automatically when the Calculator is run. To update the chart 

manually, use the Update command in the chart’s right mouse button menu.

Order Fulfillment Timeline
Days

0 5 10 15 20 25 30 35 40

Process 

Order

Order 

Approval

Scheduling Wait for Mfg Manufacturing Wait for 

Delivery

Delivery

Update Cumulative Tag Chart

Edit Cumulative Bar Chart Data

Plot Cumulative Bar Chart

Create Spreadsheet

Ladder Charts

The Ladder Chart shape allows you to create timeline and operator balance charts such as the 

following:

Operator Balance Chart
Min

0 2 4 6 8 10 12 14 16

A010De-burr 

Casting

Operator1

A020Assembl

e Lining

A030Install 

switch

Operator2

A040Solder 

Wiring

Operator3

Value Added and Non-value added Time Ladder
Min

0 5 10 15 20 25 30 35

A010De-

burr 

Casting

A020Asse

mble 

Lining

A030Insta

ll switch

A040Sold

er Wiring

Non Value Added Value Added

3. Complete the form:
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Try This:

We will plot a Timeline Ladder for the VA/NVA times from this VSM.

1. Drag out the Ladder Chart icon and click the “Edit” command in its right mouse button menu.

2. Complete the form:

3. Plot chart:

4. The chart will update automatically when the Calculator is run. To update the chart, manually, 

use the “Update Chart” command in the chart’s right mouse button menu.

Solder Wiring

13Operator3 Min

A040

9 Min

4 Min

De-burr Casting Assemble Lining Install switch

3Operator1 Min 12Operator1 Min 7Operator2 Min

A010 A020 A030

2 Min

1 Min

9 Min

3 Min

4 Min

3 Min

Ladder 
Chart

Edit Ladder Chart Data

Plot Ladder Chart

Create Spreadsheet

Ladder 

Chart

Ladder 

Chart

Value Added and Non-value added Time Ladder
Min

0 5 10 15 20 25 30 35

A010

De-burr 

Casting

A020

Assemble 

Lining

A030

Install 

switch

A040

Solder 

Wiring

Non Value Added Value Added

Update Chart

Edit Ladder Chart Data

Plot Ladder Chart

Create Spreadsheet
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7. Improve

Overview

Allows creation of an A3 sheet with a simple template and stencil.

Allows addition of improvement ideas on the map 

supported by Impact matrix, Risk matrix, and 

Kaizen Report. 

Improve

A3 Report

A3 Report

Map Copy Allows a map to be copied to another page in the file.

Map CopyKaizen Export

Kaizen Import

Renumber Kaizens
Kaizen 

Properties

Kaizen Properties

Kaizen Export

Kaizen Import

Renumber Kaizens

Select the kaizen/project property set for the map.

Creates an Excel spreadsheet of Kaizens with their property data.

Reads an Excel spreadsheet of Kaizens with property data back to 

eVSM.

Renumber the Kaizen shapes in the order they are selected. 

Numbering starts at 001, and any un-selected Kaizen shapes get 

numbered after the selected Kaizen shapes.

Kaizen Standardization

You can now standardize your kaizen custom properties by selecting the set of data for the 

kaizens on the map. The Kaizen Properties button in the toolbar will bring up a form allowing 

you to select which properties to standardize on for the map. 
Kaizen Properties
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The Kaizen Export toolbar button scans the map for all Kaizen shapes (Starbursts) and exports 

custom properties associated with the shapes to Excel spreadsheets (Pagename_Kaizen). This 

Excel spreadsheet will show the connectivity of Kaizen bursts with activities and other Kaizen 

bursts. If you want to edit the custom properties data via Excel, you may do so and import the 

data back into eVSM using the Kaizen Import button.

Kaizen 
Starburst

Problem

123

Generating Kaizen Report

Try this:

1. Open a blank Visio drawing page with the Quick Manufacturing stencil. 

2. Drag out an Activity Center.

Reduce 

Changeover 

Times

001

More Frequent 

Deliveries

002

Kaizen 
Starburst

Kaizen Export

Kaizen Import

Problems can be documented using Kaizen starbursts, which 

can now be connected to activities as well as other Kaizens.

4. Click the Kaizen Properties button in the toolbar to bring up the form to see which properties 

are available as well as a description of each.

Check or uncheck the boxes to add/

remove properties to the standard 

custom properties list when editing 

each kaizen on the map. 

Kaizen Properties

Double-click the word “Visible” to 

toggle all of the properties on or off.

3. Drag out two Kaizen Starbursts from the Quick Extras stencil. Edit the descriptions to “Reduce 

Changeover Times” and “More Frequent Deliveries”.
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Kaizen Impact Matrix

Try this:

5. Click the Kaizen Export button in the toolbar to create a Kaizen Report in Excel. Kaizen Export

ID Kaizen Process Step Data Data Data Data Data Data Data Data Data Data Data Data Data
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Uni t Unit Unit Unit Unit Unit Unit Unit Unit Unit Unit Unit Unit

1 Reduce Changeover Times Process 1 1 1 1

2 Make Frequent Del iveries Process 1 1 1 1

The Kaizen impact matrix was introduced in a late version of v5 and uses the “Impact” and “Ease 

of Implementation” custom properties of kaizen starbursts to plot an impact matrix. The goal of 

the matrix is to help select projects for implementation to improve the value stream.

The mini-kaizens in the matrix copy the custom properties of the originals (map kaizens). They 

are numbered based on the ID’s of the Kaizens on the map (ID’s are circles glued to the top left 

of the kaizen shapes). A right-mouse click on any of the mini-kaizens allows for selection and 

highlighting of the parent map kaizen. 

6

Highlight Kaizen

1. Change the Impact and Ease of Implementation properties of each starburst by right-clicking 

the burst and selecting “Edit Kaizen”. A form will appear allowing you to edit the various 

properties. Similarly, you could also edit the values via Excel spreadsheet and use the Kaizen 

Import button to bring the values back into eVSM.

Impact (1-5):  What impact this project will have on 

the value stream.

1 = Low, 5 = High

Ease of Implementation (1-5):  How easy/difficult 

will it be to implement this measurable 

improvement to the Value Stream?

1 = Difficult, 5 = Easy
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Reduce 

Changeover 

Times

More Frequent 

Deliveries

Kaizen Impact 
Matrix

Plot Kaizen Impact Matrix

001 002

2. Change the fill color of each starburst if you wish.

3. Drag out the Kaizen Impact Matrix icon from the Quick Extras stencil and right-click to plot 

the matrix, which is shown on the next page.

4. If map kaizens are modified, then the Impact matrix can be updated by selecting it with a right 

mouse click and the command “Update Chart”.

5. Using the Renumber Kaizen button in the toolbar, kaizens can be renumbered in order starting 

at 001. You must select the bursts in the sequence you want using the Shift key, and then click 

the Renumber Kaizens button. Any un-selected kaizen shapes will get numbered after the 

selected kaizen shapes. 
Renumber Kaizens

Kaizen 

Impact 

Matrix
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6. Drag out the Kaizen Key Creator from the eVSM Main stencil to differentiate each burst by 

description which is shown under the matrix.

Kaizen Key 
Creator

(001) Reduce Changeover Times

(002) More Frequent Deliveries

Kaizen 

Data

5

4

3

2

1

1 2 3 4 5

Ease Of Implementation

Im
p

a
c
t 
O

n
 V

a
lu

e

Kaizen Impact Matrix

001

002
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Kaizen Risk Matrix

Try This:

1. Drag out a Kaizen starburst shape from the Quick Extras 

stencil. Type “Reduce Cycle Time” into the burst. Enter the 

values for the likelihood and severity by clicking “Edit 

Kaizen” via right-mouse menu.

Reduce Cycle 
Time

001

2. Drag out another Kaizen Starburst. Type “Incorrect 

Assembly” into the burst. Enter the likelihood and severity 

values via the Edit Kaizen form.

Incorrect 
Assembly

002

3. Drag out the Kaizen Risk Matrix from the Quick Extras 

stencil.
Kaizen Risk 

Matrix

The Kaizen Risk Matrix plots the kaizen starbursts based on the risk likelihood and risk severity 

values set up in the “Kaizen Properties” form brought up from the right-mouse menu. It also 

multiplies the values together to create an RPN number between 1 to 25.

Risk Likelihood (1-5):  What is the 

likelihood of risk to the Value Stream if this 

project is not done/issue is not addressed?   

1 = Low, 5 = High

Risk Severity (1-5):  What is the 

likelihood/impact in the Value Stream if 

this identified risk did actually occur?   

1 = Low, 5 = High

Kaizen 

Risk 

Matrix
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4. Right-click the chart shape to plot.
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Formatting the Kaizen Report in Excel 

Once you have clicked the Kaizen Export button in the toolbar and your Excel spreadsheet 

appears, there should be a page named “KaizenFormat”. The changes made on this page will 

effect the actual report which is page named “PageName_Kaizen”. 

Template page for 

editing properties 

for the Kaizen 

Report

In the “KaizenFormat” page in the spreadsheet:

· 1,4: Change the font color and/or fill color of this cell to set these properties for all data 

headers 

· 2,4: Change the font color, boldness, or italics and/or the fill color of this cell to set these 

properties for all variable names

· 3,4: Change for the fill color or row height of this cell to set these properties for all units

· 5,2: Change the fill color of this cell to set this color for all kaizen numbers

· To hide an entire row or column, right-click the row number or column letter and choose 

“Hide”. To unhide that row or column, select the row before and after the hidden one by 

holding down the SHIFT key, or the column before and after the hidden one, and then right-

click and select “Unhide”.

Page name of 

Calculations 

page from 

“Solve”

A ReadMe page that 

lists any editing 

instructions for 

importing values   

Kaizen Report 

(PageName_Kaizen)

The Kaizen Report in Excel can be formatted with custom properties of color, font, visibility, and 

row height. In order to be able to edit this formats, you need a specific Excel file. To get this file 

in the correct location for usage:

1. Create a new folder called "eVSM Standards" at the same level as the “eVSM” folder on the 

C: drive>Program Files (x86)

2. Copy the templates file called “eVSMExcelTemplate” from the C:Drive>Programs Files 

(x86)>eVSM>Setup>Resources folder to the newly created “eVSM Standards” folder

3. Customize the templates file as needed by following the instructions below
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This function provides a template (below) of an A3 report and a set of icons to make it easy to 

visualize the “Current Condition” and “Desired State” aspects of the sheet. Click the A3 toolbar 

button to create a new report. Zoom into the appropriate area and fill out the sheet.

Creating A3 Reports

A3 Report
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Pra
ct

ice

Hospital

Hospital

When to 

Operate ?

Erratic OR Priority 

Overrides
No centralized 

booking
Insurance Impacts

A typical “Current Condition” 

diagram is shown above and can 

be drawn very quickly in eA3 

using the available icons.

You can drag and drop a people shape from the stencil. You can change a person’s “role” by 

clicking the right mouse button and selecting the role (nurse, doctor, etc..). You can also set a 

person’s expression in the same way. People stacks are available for mfg, services, and 

healthcare.

Diagramming the Current Condition

Representing People

Healthcare 
People

Pharmacy

Pharm
acy

Pharmacy

Pharmacy

Icon 
Of 

Place

You can create an iconic representation of a department by 

gluing an icon to its center. You can also type in the name.

The square frame of the dept icon can be hidden with the right 

mouse “framing” option for a simpler look.

High Roof 
Place

Low Roof 
Place

Representing Departments

Healthcare 
Depts

Healthcare 
Depts

Healthcare 
Depts

Glue point is here

Glue point is here
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Typically used to identify problems
Problem

Solution

Text

Typically used to identify solutions or positive 

attributes of the “Desired State”

Typically used to denote thoughts or verbal 

communication

See the “Draw” and “Gadgets”  sections to see how  these items can be used on an A3 Report.

Problems, Solutions and Callouts

Icon Stacks

Tables and Gadgets in A3 Reports

Healthcare 
Depts

Healthcare 
People

Mfg 
People

Service 
People

Mfg 
Depts

Service 
Depts

Healthcare 
Items

Transmit 
Shapes

Transport 
Shapes

Kaizen 
Cloud

Kaizen 
Starburst

Callout

Map Copy

Using the Map Copy button in the toolbar, eVSM can copy your map to another page in the file. 

This function saves time as opposed to using Visio’s regular copy and paste functions. 

1. Click the Map Copy button in the toolbar.

2. A box will appear asking you to enter a page name for the new page in the file.

3. Type in a new name for the page that is going to be created and click OK. 

4. Your entire map will be copied to this new page in the same file. 

Map Copy

Drag out any of these blue stack shapes and right-click to select from the other shapes available.
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8. Extras

Overview

Provide utilities for upgrading older eVSM maps to v7.

Allows drawing of a simple spaghetti diagram with reporting on 

distances to Excel.

Opens a stencil with Event (or communication) circle shapes.

Provides additional diagrams used by lean practitioners such as the 

Spaghetti Diagram and the Communication Circle. Also, has a 

migration utility which helps update older maps to eVSM v7.

Extras

Spaghetti

Event Circle

Event Circle

Spaghetti

Migrate Maps to eVSM v7

The following button in the toolbar will migrate eVSM v2, v3, v4, and v5 maps to eVSM v7 

format.

Once a map is migrated to v7, it cannot be opened in older releases of eVSM.

If you need to open an eVSM v7 file in, say v3 (or any earlier version of eVSM) for viewing/

printing purposes only, here is a workaround:

1. Start eVSM and switch VB Macros Off. Click “Tools > Options > Security”.

2. Switch “Off” this checkbox.

3. Exit Visio and open the eVSM v7 file.

Note: Remember to reverse Step 2 above when you wish to use eVSM v7 again.

Migrate

Migrate

Migrate
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Spaghetti Diagrams highlight wasted journeys and effort by visualizing motion between activity 

centers. The eVSM Spaghetti Diagram function allows you to draw paths on a floor plan (or any 

geographic map) and then export a Path Report to Excel.

Drawing Spaghetti Diagrams

Try This:

Floor Map

Spaghetti Path

Spaghetti Place

1. Draw or import a floor map. Visio can import most bitmap formats as well as AutoCAD 

drawings. Either use the “Insert” tab in Visio or simply copy and paste the picture into a 

new drawing.
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2. Click the Spaghetti Diagram button in the eVSM toolbar. This will open the eVSM 

Diagrams stencil. 

Spaghetti

3. Drag out a Spaghetti Scale shape from the eVSM Diagrams, 

and stretch it out to exactly fit a known dimension on the 

map. The known dimension could be a map scale if available, 

or a floor dimension you have measured. Enter the actual 

dimension value on the scale shape.

10

4. Define Activity Centers by dropping and naming a 

Spaghetti Place icon onto the diagram for each place.
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5. Use the Visio line drawing tools to map the paths. You must ensure that each path starts and 

ends in a Spaghetti Place icon. You can set color and line thickness of the paths using 

standard Visio formatting.

In Visio 2003/2007, the line drawing tools are in the Drawing Toolbar. This can be opened 

via the right mouse menus on the Visio Toolbars.

In Visio 2010, the drawing tools are near the center of the "Home" ribbon.

Any of the line tools in 

the Drawing toolbar can 

be used

Line tools in 

Visio 2010

10
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6. Click the Spaghetti Diagram button again. eVSM will create a spreadsheet report of the 

paths.

7. Additional attributes can be added to the path lines via Visio Custom Properties. Select a 

path line, and right-click “View>Custom Properties”.

The next time the Spaghetti report is generated, the path attributes will be transferred to the 

report.

Note that the Spaghetti Diagram button recreates the Excel report. It DOES NOT update it. 

Spaghetti

10

FROM Registration

ER Bay 9TO

DISTANCE 102

SEQUENCE 1

DESCRIPTION Patient assisted in wheelchair

DATE 3/3/2007

TIME 5:36pm

C
u

s
to

m
 P

ro
p
...

TO COLOR DESCRIPTION DATE TIME DISTANCE

ER Bay 9 Patient assisted in wheelchair 3/3/2007 5:36pm 102

X-ray waiting area patient escorted to X-ray waiting area 3/3/2007 6:20pm 58

X-ray Room 1 Patient to X-ray 3/3/2007 6:32pm 27

ER Bay 9 Patient returned to Bay 9 3/3/2007 6:45pm 62

Spaghetti Report in Excel
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Event or Communication Circles allow you to visualize all the transactions in a given pathway or 

process. Example:

Drawing Communication Circles

Try This:

Number Of Steps = 15

PHYSICIAN

PATIENT

VOLUNTEER

BILLING

SOCIAL 

SERVICES
ADMITTING

NURSE

CHARGE 

NURSE

ER 

UNIT 

CLERK

1. Follow a pathway or process and record all transactions 

in an Excel table in the following format. The first row in 

the spreadsheet must contain the exact column headers as 

shown. The communication circle code is looking for the 

“From” field in cell A1 in the worksheet. Save the Excel 

file anywhere on your machine.

2. In eVSM, click the Event Circle button in the eVSM toolbar. This 

will open the “eVSM Diagrams” stencil.

Event Circle
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4. Click the “Import Communications From Excel” command in the right mouse button menu 

of the circle.

Import members from Excel

Import Communications From Excel

Export Members To Excel

Export Communications To Excel

Update Number of Steps

3. Drag out a Communication Circle shape from the “eVSM Diagrams” 

stencil. This will create a blank circle on your drawing. Adjust the 

position and size of the circle to your liking.

Number Of Steps = 0
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5. Select the Excel file and click OK. If you have more then one worksheet in the Excel file 

with communications data, then you will be prompted to select the worksheet to use.

6. The communication circle may be edited directly in Visio where you can change, add, or 

delete circle members. You can also move, add, or delete Communication Paths. 

Communication Paths can also be color coded to show different types of communications 

(phone, fax, patient initiated, etc.).

After making changes, use the “Update Number of Steps” command in the right mouse 

menu to update the number of steps.

Number Of Steps = 5

Registration

Patient

Nurse
Unit Clerk

Physician

Circle member 
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9. Learn

Overview

Accesses the eVSM on-line help site.

Builds a page full of all the choices available in an eVSM Stack shape 

master. Select a blue or green eVSM icon from Quick Extras or any 

Quick stencil before running this tool.

Provides an on-line access to help resources, example maps, and 

training options. 

Help

Icon Help

Help

Learn

Icon Search Search for shapes in eVSM stencils.

Icon Search

Stack Help

Stack Help
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Cycle Time Minx.xx

Name Help

For variable name help, right-click any variable and select 

“Name Help” in the menu for a description of the variable.
Process

1

Qty Per Cycle Item1

1

A0020

MinAuto
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Icon Search

The Icon Search button in the eVSM toolbar allows you to search for icons in any of the eVSM 

stencils. The search looks at the name and the brief help behind each icon and presents results in 

a separate search stencil.

1. Click the Icon Search button in the Learn module of the eVSM toolbar. 

2. Look for “OEE” in the Quick Mfg stencil.

3. The resulting shapes associated with OEE will be brought up in a new search stencil.

Try This:
Icon Search
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Stack Shape Help

The Stack Help button creates a new page in the file with all of the available shapes for a 

selected stack. An icon can be identified as a stack shape if it is blue or green in an eVSM 

stencil.

Try This:

1. Select the blue stack Transport Shape from the Quick Extras stencil.

2. Click the Stack Help button in the eVSM toolbar.

3. A new page will be created with the page name “Transport Shapes_Stacks” in the file with all 

of the shapes in the Transport stack. 

Stack Help
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Quick eVSM consists of ready-built stencils for specific application areas. Using these Quick 

Stencils will increase productivity and reduce learning time.  Quick eVSM stencils are on the left 

side of the screen. Application areas supported include:

§ Quick Manufacturing - plant level maps for discrete 

parts

§ Quick Transactional - transactional processes 

§ Quick Healthcare - patient flows in healthcare

§ Quick Enterprise - supply chain and logistics maps

§ Quick Processing - plant level maps for food products 

and chemical processing

§ Quick MCT- supports manufacturing critical path time 

calculation assorted with Quick Response 

Manufacturing

The Quick Stencils will be located on the left side of the 

Visio drawing page. Quick stencils contain macro shapes 

which are collections of individual shapes, sometimes with 

names, units and calculation equations built-in.

Quick eVSM maps must be initiated with the red icons 

found at the top of each Quick stencil. Once the red icons 

from a Quick stencil have been dropped on a page, the page 

is locked for use with that Quick stencil. You cannot add 

content from other Quick stencils. You can however add 

icons from the main stencil (right side) at any time. 

Some icons (eg. Arrows) are available only in the main 

stencil.

10. Quick eVSM

Overview
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Quick Stencils Icon Colors

Red icons are used to initiate the map for the chosen application area. Red icons 

must be dropped first on the new map. The red icons block the map from being 

used with any other Quick stencil.

Green icons, called “Centers”, are used to represent the flow.

Yellow icons, called “add-ons” are additions to “centers” for optional 

calculations. These add-ons must be properly glued to the data shapes under the 

Center. The yellow icons that follow a Center in the Quick stencil can only be 

used with that Center. Note the first word in the add-on names matches the parent 

Center.

Magenta icons represent charts.

White icons used for miscellaneous macro shapes.

The red Data icon acts as the vault for all of the system data for the map such as names, units, 

equations. Each stencil has its own data icon that must be dragged out first. 

Red Icons in the Quick Stencils

Manufacturing
Data

Customer
Center

all

Customer

Customer 
Demand

Item
Day

xx

A020

The Customer Center represents the customer is where the customer demand is specified. Where 

multiple customers exist, a separate Center can be used to represent each customer.
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Time Center

The Time Center shows the actual time (after deducting break times) the value stream operates 

for. Activity level local time can be specified for activities which work to a different schedule. 

Other units are available.

xx

Day

Hr

5

Wk

Day

Quick Stencils Centers (Green Icons)

The Centers typically come out with tags and data shapes properly glued to the parent shape 

(green icon)

This is an Operation 

Tag used to sort 

data for charts.

Path ID. Used to show specific 

paths. Also used to filter data for 

calculations and charts.

The green shape acts as 

the parent. If moved, 

everything glued to it will 

move with it. 

1

minAuto

Qty Per Cycle Item1

Cycle Time Minx.xx

Cycle Time Per Unit
Min
Item

Auto

Activity Takt Time
Min
Item

Auto

Activity VA Per Unit
Min
Item

Auto

A020

Process

1

Capacity
Item
Day

Auto

Computed Demand
Item
Day

Auto

EC
Item
Day

Auto

Computed Activity Time
Hr

Day
Auto

xx represents mandatory 

data items. Without this 

data, the calculations 

cannot be completed.

Units can be changed to 

other compatible units by 

double-clicking.

Blue “Auto” fields will be 

calculated automatically 

be eVSM.

Quick Manufacturing

The Quick Manufacturing stencil is designed to represent discrete parts flowing through plant 

level manufacturing value streams. Both, the material and information flow may be represented. 

The Quick Manufacturing stencil includes built-in calculations for:

§ Lead Time, Value added time, Takt time

§ Scrap, OEE, and other common activity losses

§ Energy and space calculations

§ Multi-stations, part-time, over-time, shared resources

§ Cost of activities, inventory, transport, scrap

§ Transport distances

§ Multi-paths

For tutorials and examples visit: 

http://www.evsm.com/help
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Quick Transactional

Used to draw office, administrative, and general services value stream maps. May be used for 

any value streams concerned primarily with information flow. 

For tutorials and examples visit:  

Supported calculations include:

§ Lead Time, Value added time, Takt time, Cumulative Rolling Time

§ %Complete & Accurate (%C&A)

§ Multi-stations, part-time, over-time, shared resources

§ Multi-paths

http://www.evsm.com/help

Quick Healthcare

Used to capture value streams that require following a patient through admin and non-clinical 

processes.

For tutorials and examples visit:  

Supported calculations include:

§ Lead Time, Value added time, Takt time, Cumulative Rolling Time

§ %Complete & Accurate (%C&A)

§ Multi-stations, part-time, over-time, shared resources

§ Multi-paths

Quick Enterprise

The Quick Enterprise stencil is designed to provide mapping support for enterprise, supply chain 

and logistics maps. The stencil was developed after a review of the workbooks “Seeing The 

Whole” and “Lean Fulfillment” from the Lean Enterprise Institute (www.lean.org). The stencil  

has been subsequently refined through enterprise mapping projects the eVSM group has been 

involved in.

For tutorials and examples visit:  

The Quick Processing stencil is designed to provide mapping support for plant level 

manufacturing in Process Industries. The stencil was developed after a review of the Peter King’s 

book “Lean for the Process Industries”. It is an adaption of standard Value Stream Mapping 

methodology to address the non-discrete nature of process manufacturing.. The stencil  has been 

subsequently refined through processing mapping projects the eVSM group has been involved in.

For tutorials and examples visit:

Quick Processing

http://www.evsm.com/help

http://www.evsm.com/help

http://www.evsm.com/help
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Identify operations in the value stream and start at the customer end. 

Use the right mouse button to swap to another process shape.

Identifying Operational Steps

Process

Operation 
Shapes

Identifying Customers

Start the map at the customer end.

Drag out the ‘Operation Shapes’ icon and right-click the shape 

to change it to a customer shape. 

Appendix A : Drawing with Base eVSM

Process

Operation Shapes

Process

Process

Drag and drop, then glue arrows to the operations or their data 

shapes for easy future modification of the map.

Use the right mouse button to swap to another arrow type (like 

this Push arrow)

Connecting Operational Steps with Arrows

Stepped 
Arrows

Expedited

Information

Kanban

Material

Push

Service

Adding Operational Data

Value stream data which you may later want to use in calculations must be represented in eVSM 

data shapes. eVSM has the following data shapes:

ValueName Unit Value Unit Value Unit

Long NVU Value 
Added

Non Value 
Added

Name Unitx.xx

Short NVU

94



ValueName Unit

Process

ValueName UnitValue

Name

Unit

Value Unit

Value Unit

Variable Names and Units

To add variable names/units to the right mouse button (RMB) menu, follow these steps:

1. Click the following button in the eVSM Toolbar to open the Name & Unit Manager (NUM) 

dialog.

2. To add a new unit, click the “New Unit…” button.

3. All variable names must have 

a default unit. When adding 

new variable names, first 

make sure that the unit you 

wish to make the default for 

the new variable, exists in 

the units list. Then, click the 

“New Name…” button and 

follow the prompts.

NUM

Data shapes consist of two or three fields. To move or delete a data shape, you MUST click on 

the Value field. To edit any of the fields, simply double-click on the desired part and you will be 

able to make any changes.

Data shapes must be glued directly, or via other 

shapes, to the activity they represent.
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How do I work with Data Blocks?

The following steps demonstrate how to add and edit data blocks. In this example, the data 

blocks associated with an Activity Center will be reformatted and customized.

1. Start by dragging out a shape from the Sketch stencil or an Operation Shape from the 

eVSM stencil. 

2. There is a Data Blocks stencil that has a selection of different sized NVU’s in various 

formats to customize your map. One option is to have an IVU which you can choose the 

image to go along with the variable. Delete the long Cycle Time NVU and drag out the 

“Left Tiny IVU.” Double-click the image to change it to Cycle Time.

3. Fix any other data blocks that may have moved when the Cycle Time IVU was adjusted  If 

the image doesn’t appear, or if you are adding a custom image, double click on the image 

portion of the data block and select “Manage Names and Units…”

4. In the Names and Units Manager, double click on the Name of the data block being edited, 

in this case, “Cycle Time.”

5. Click on “Pick Graphic” to select an image for the data block from an image menu. For 

Cycle Time, the cycle was selected.

This is a basic Activity shape without 

calculated variables, tags, or paths. It contains 

one short IU (associate image and unit) and two 

long NVUs (cycle time and qty per cycle).

Process

Cycle Time Minx.xx

Qty Per Cycle Item1

1
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6. Click “OK” for all of the different menus to add the selected image to the short IVU of 

cycle time.

7. To change the framing of the data block, right-click on the IVU and select either “No 

Framing” or “Box Around.” You can also set the fill of the data block to “No Fill” in the 

Visio toolbar.

Activity

1

Qty Per Cycle Item1

Minx.xx

Activity

1

Qty Per Cycle Item1

Minx.xx

Activity

1

Qty Per Cycle Item1

Minx.xx

No Framing Box Around

There are endless variations possible with the amount of data block formats available. Some 

examples are shown below:

Activity

1

Two short NVU’s to save room

Data Block Examples

Cycle 
Time

Minx.xx Cycle Time 
Per Item

Minx.xx

Activity

1

Activity

1

Short IVU and short NVU

Minx.xx

x.xx

Short IV and short NVU, no units, with box around 

rather than framing

Cycle Time 
Per Item

Minx.xx

Cycle 
Time

Minx.xx
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3CO min

20CT sec

3CO min

20CT sec

Process Additional data can be added to a process. Drag & glue a new NVU to 

the bottom of an existing NVU.

Data shapes that do not touch the operation or its data shapes directly 

should be associated with the operation by dragging the flying yellow 

connector and gluing it to the operation.

Note: Flying connectors should NOT be used where shapes are 

touching.

Process

Adding Additional Data Shapes

Long 
NVU

x.xx Unit

xx
Day

s
xx Unit

Process VA and NVA shapes are available to construct a timeline on 

the map.

Glue these shapes to operational shapes with a flying 

connector.

When there are several VA/NVA metrics to be tracked, the 

Long NVU shape should be used instead of the specific VA, 

NVA shapes.

Process

Representing VA & NVA data

Value 
Added 

Non Value 
Added 

Drag out the NVU shape and glue it to the bottom of the inventory rectangle 

to document inventory type and quantity. Use additional triangles and NVU 

blocks for each inventory type.

Representing Inventory Data

After an inventory shape has been dragged out, it can be changed to a variety of inventory 

shapes. Use the right mouse button to swap to another inventory shape (Queue, In-tray etc..).

Representing Inventory & Queues

Inventory 
Shapes

Short NVU

Delay

FIFO Inventory

Hopper

In Tray

Inventory

Kanban Inventory

Package Forming Inventory

Query

Queue

Silo

Supermarket Inventory

Wait

Inventory
Ite
m

20
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20

LH

plts

Supermarket and Buffer shapes work in a similar way to the Inventory 

Shape. Any data must be glued to the base of the shape.

Representing Supermarkets and Buffers

Supermarket

Short NVU

Drag out Transport Shapes and place them on the map or glue them 

to arrows. NVU shapes holding related variables can be attached to 

the base of the icons.

Use the right mouse button to swap to another transport type 

(Train, Helicopter etc..).

Representing Transport Method and Data

Process

Transport 
Shapes

Finished Goods

Representing Transmit Method and Data

Transmit Shapes work in a similar way to Transport 

Shapes and are generally applied to information 

flow.

Transmit 
Shapes

Control 

Activity

Frameless Transport & Transmit Shapes

Transmit 
Shapes

By Foot

Computer

Fax

Pager / Radio

Phone

Post

Print

Web Form

_______________

Framing

Right-click on a transmit or transport shape on the map to show 

alternate methods.

At the bottom of the list is a “Framing” option that allows the 

outer box around the shape to be turned on or off. When turned off 

the shape looks as below:
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Table

This  is a simple starter table that can be further customized:

A right mouse click on any  of the table cells brings up a 

table modification menu (right) allowing for row / column 

addition and modification.

Select Table

View Row and Column Size 

Adjusters

Adjust Table

Clone Row Below

Clone Row Above

Delete Row

Use as Standard Row Height

Clone Column on Right

Clone Column on Left

Delete Column

Use as Standard Column Width

The eVSM Table shape was introduced to allow easy creation of box-score tables on the map.

Starter Table

Working with Tables

Pick the “Select Table” command in the right mouse menu to highlight the 

yellow diamonds. Move these yellow diamonds to the required width and 

height positions. Then click the “Adjust Table” command in the right 

mouse menu.

Resizing Rows and Columns

Moving the Table

To move the table to a new position on the map, click the “Select Table” command in the right 

mouse menu. Then drag the table to the desired location.

Editing Text

Double-Click on a table cell to change its text.
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Header1 Header2

Value2Value1

Header2

Value2

Tables and Spreadsheets

You can transfer table cell data to the spreadsheet with the “eVSM Calculator” button

To transfer the data, the table has to be tagged first.

Each table creates its own worksheet page in the Excel Workbook. If the page name is “CS” and 

the tag is “A010” then the worksheet in Excel will be called “CS_A010”. If formulas are created 

within cells in the spreadsheet, the results of those formulas will appear in the table when the 

eVSM Solve button is clicked.

Operation 
Tag

Solve

A010
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Swimlanes

The eVSM Swimlane function allows drawing of VSMs and flowcharts in swimlane layout, 

horizontally or vertically. The eVSM Swimlane shape is an implementation of the eVSM Table 

function. 

To calculate totals or plot charts for each lane, see the Path Locator function.

Note: The swim lane function in native Visio is NOT supported with eVSM. The eVSM 

Calculator will not work if the Visio swim lane shape is on your drawing page.

Horizontal 
Swimlane

Vertical 
Swimlane

Lane A     Lane B

L
a
n
e
 A

L
a
n
e
 B

3. Pick the “Select Table” command in the right mouse menu to 

highlight the yellow diamonds. Move these yellow diamonds to the 

required width and height positions. Then click the “Adjust Table” 

command in the right mouse menu.

4. Double-click the “Header” to edit the text.

5. To move the table to a new position on the map, click the “Select Table” command in the right 

mouse menu. Then drag the table to the desired location.

Try This:

1. Drag out the Horizontal Swimlane from the main stencil. 

2. Right mouse click on any of the lanes to bring up the 

modification menu allowing for row/column addition and 

modification.

Select Table

View Row and Column Size Adjusters

Adjust Table

Clone Row Below

Clone Row Above

Delete Row

Use as Standard Row Height

Clone Column on Right

Clone Column on Left

Delete Column

Use as Standard Column Width
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Only shapes with a grey corner in the stencil can be tagged. These are called Excel rowmaker 

shapes since each of these creates its own row in the spreadsheet. 

Row shape examples:

Excel Rowmaker Shapes

Operation 

Shapes

Transport 

Shapes

Table Transmit 

Shapes

Common Calculator Problems

The eVSM Calculator has some requirements, and if these are violated, the calculator will stop 

and display an error message. The problem area will be highlighted on the map with a red circle 

for you to correct.

Appendix B : Analysis with Base eVSM

Map.xlsMap.vsd

When the eVSM Calculator is run for the first time, the Excel file is created automatically and 

saved in the same folder as the Visio file. The Excel file is given the same name as the Visio file. 

Unit conversion variables in Excel are also scoped by the page name.

Excel and Visio File Naming

Solve

Duplicate or Unglued Tags: Each Operation Tag on the map must have a unique value and must 

be glued to a valid Row Shape.

Overlapping Data Shapes: Some Data Shapes are hidden behind others because of overlap, and 

is not allowed.

Duplicate Data Shapes: Each Data Shape within a Row Shape collection must have a unique 

variable name. 

Grouped Shapes: eVSM Shapes should not be grouped. The Calculator will abort if grouped 

shapes are found.

Common Calculator Problems
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Data columns sorted 

by variable name

Data in Excel

One row per 

Rowmaker Shape

Rows sorted by 

Operation Tag 

number

All items in a column have same units

Calculations in Excel

Equations may be entered in the spreadsheet cells in which Data Shapes are represented. 

Steps:

The next time the Calculator 

is run, the result of the 

equation will be displayed in 

the appropriate data shape on 

the map. The calculated value 

will be color coded red to 

show it is controlled by Excel.

Note: After the “=” sign, instead of an equation (eg. =C3*D12), static values (eg. =216) can also 

be entered. This allows entry of measured metrics directly in the spreadsheet.

Select 

Cell

1

Type “=” followed 

by an equation

Click the Enter 

button

2

3
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eVSM Equation Manager

Visio

Build

A10

22Cycle Time Secs

96Yield (%) %

Pack

22Cycle Time Secs

96Yield (%) %

A30A20

135

Distance

ft

5Rework (%) % 2Rework (%) %

xx Days

xx Secs xx Secs

All eVSM calculations are done via an integrated Excel spreadsheet. The spreadsheet is created 

automatically when the “eVSM Calculator” function is invoked. Results from calculations in the 

spreadsheet are automatically displayed on the map. eVSM supports two types of equations to 

perform the calculations:

1. Direct Equations – formulas entered directly into cells in Excel.

2. Managed Equations – equations managed by eVSM and automatically inserted as formulas 
in Excel.

This section shows the Managed Equations capability in eVSM.

Managed Equations are created in Visio and stored in the NUM shape. 

When the eVSM Calculator is run, they generate Direct Equations in Excel. 

The Equation Manager form is accessed through the Name and Unit Manager.

Tag Operation VA NVA Data Data Data Data

v
a

lu
e

 a
d

d
e

d

n
o

n
 v

a
lu

e
 a

d
d

e
d

c
y
c
le

 t
im

e

d
is

ta
n

c
e

re
w

o
rk

 (
%

)

y
ie

ld
 (

%
)

secs days secs ft % %

A010 Build xx 22.00 5.00 96.00

A020 Hand Cart 135.00

A030 Pack xx xx 22.00 2.00 96.00

Excel

=($AE$18)*100/(($AF$18)*1440)

Name 

Unit 

Data

Managed Equations are 

created and stored in 

Visio

Direct Equations 

in Excel

Solve

List of Managed 

Equations
On/Off switch 

controls whether or 

not equation will be 

applied when 

Calculator is run

NUM

Creating Managed Equations

Non Value Added (Days)   =
Inventory (Units)

Daily Demand (Units/Day)

In this example, we will set up a Managed Equation to calculate the Non-Value added (NVA) 

times associated with inventory and daily demand. The equation is:
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Our goal is to use a single equation for the variable “Non Value Added” that is applied 

everywhere on the map where this variable exists. We will assume two key rules of the Equation 

Manager:

§ There is only one equation for each target variable name (left-hand side of the equation).

§ An equation is either applied to the whole map (when it is ON), or not applied at all (when 

it is OFF).

Steps:

1. Click the New Eqn.. Button.

3. Enter a name and 

description (optional) 

for the equation.

2. Select the variable name to calculate and its 

corresponding units. This represents the left-hand side 

(LHS) of the equation.

4. Click Insert 

Variable for the 

right-hand side 

(RHS) of the 

equation.

5. Select “Inventory” for  

variable name and select 

the unit

6. Specify 

action to take if 

variable is not 

found on map

7. Select the “ST” option. This specifies how data will get selected from the map. The selections 

are based on the Operation Tag and are explained further in the following pages. 
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8. Click “OK” to return to the previous form. 

9. Type “/” for the divide sign

Solve

Equation Manager Variables Options

§ Same as Target Tag (ST) – Used to select the RHS variable from the same operation tag 

as the LHS variable.

§ Unique Variable On Map (UV) – Can be used when a variable occurs only once on the 

map, so there is no need to specify the operation tag ID for it.

§ All Tags (ATS) - Selects the RHS variable from every tag on map where it exists, and 

makes a list to put in the Excel function. Typical usage: sum all VA times.

§ Downstream Tags (DTS) – Selects the RHS variable from the downstream tag as specified 

by the Tag Seq arrows connecting the tags. Typical usage might be for cumulative 

calculations starting downstream and moving upstream, like effective yield calculations.

§ Upstream Tags (UTS) - Selects the RHS variable from the downstream tag as specified by 

the Tag Seq arrows connecting the tags. Typical usage: cumulative time or cost 

calculations.

11. To convert the Managed Equation into Direct Equations, click the Calculator button.

10. Insert the next variable for the RHS. 

Here is the resulting equation:

“ST(Inventory;Unit;0;SKIP)/ST(Customer 

Daily Demand;Unit;0;SKIP)”

To edit variables in the equation, place the 

cursor on the variable and click the 

“Modify Variable..” Button.
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Block Managed Equations

Each target variable (left-hand side of equation) can be driven by only one Managed Equation. 

When the Calculator is run, the Managed Equation will be applied to every instance of the target 

variable. Sometimes, you may want to block the Managed Equation from being applied to some 

instances of the target variable. This can be done with the “Block Managed Equation” shape in 

the eVSM Icons stencil.

Simply glue the “Block Manage Equation” shape to any data shape which you want omitted from 

the Managed Equations calculation.

Note: If the “Block Managed Equation” shape is attached to a data shape AFTER it has already 

been calculated, then you must manually delete its direct equation in Excel before the next 

Calculator run, otherwise the OLD equation will remain in the spreadsheet.

Block Mng 
Equation

x.xxYield %

x.xx Mins

Sequence Arrows & Pipe

The eVSM Equation Manager has additional variable options for usage with variables on 

sequence arrows and pipes. These are primarily development tools for eVSM’s quick stencils and 

their usage without developer training is NOT recommended.
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